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Welcome 

Welcome to PerkinElmer’s Line of Chromatography Software 
Products 

Your Global TotalChrom Support team would like to do everything possible to help 
you become quickly productive with this product. Before running the software, please 
take a few moments to review this tutorial. It is intended to provide you with an 
overview of how to get the most out of your investment and our software support or-
ganization. These are some of the most important pages you will have to read over the 
next few days, so please share this information with all users of this product.  

Topics include: 

• Where Do I Begin? 

• About Installation 

• How Can I Be Productive Quickly? 

• What If I Have Problems? 

• What About Software Updates and Upgrades? 
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Where Do I Begin? 

Register with Software Support 
You must be registered with PerkinElmer Software Support so that you can qualify 
for a support program and be notified of software enhancements as well as any 
problems.  

• TotalChrom Client/Server customers: Your signed Software License Agreement 
fulfills this requirement. 

• TotalChrom Workstation customers: You must fill out your permanent License 
PAK application and send it to PerkinElmer by following the directions on the 
form. If you do not currently have your permanent License PAKs from the 
TotalChrom PAK Administrator, you are probably not registered with us. 

• TotalChrom Turnkey customers: Turnkey systems are shipped with the software 
and permanent PAK installed on the hard drive.  

Note: Turnkey customers should only follow the installation instruction card 
provided with their system and skip all sections in this tutorial that are related 
to installation. 

Users New to Computers 
If this is your first experience with computers, we suggest that you become familiar 
with your system and with Microsoft Windows® before proceeding. You do not need 
to be an expert to run a computer, but at least one person at your facility needs to be 
comfortable with the operating system. The best place to start is with the Windows 
documentation supplied with your computer. We highly recommend purchasing third 
party tutorials and quick reference programs available at your local software store. 
These are economical, fun, and have the advantage of letting you work on your 
system at your convenience. You can also attend introductory computer courses that 
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are available at local community colleges, technical schools, and even local software 
stores. 

Users New to Microsoft Windows 
TotalChrom performance, functionality, and ease of use are dependent on the correct 
installation, configuration, and an understanding of basic Windows operation. Before 
you begin to operate TotalChrom (or any Windows application), we strongly suggest 
spending some time getting comfortable with this new environment. If you follow the 
routine below, your chromatography processing will be enjoyable and productive. 

1. If you did not purchase a computer from PerkinElmer, make sure the 
computer used for TotalChrom is configured according to the minimum 
TotalChrom requirements (refer to the product release notes). We 
cannot support our products on any system configuration that does not meet 
these requirements. 

2. Do not attempt to operate Windows applications without first 
understanding how to operate Windows. Windows, not TotalChrom, 
controls basic operations such as file opening, closing, saving, and printing. 
It is much easier to learn how these operations function in a basic application 
distributed with the Windows program (such as Write and Paint) before 
continuing. The first few sections of the Windows User’s Guide provide 
excellent startup tutorials for your personnel. Spending some time with these 
will greatly enhance your implementation efforts. 

3. Make sure the operating system is operating smoothly on your 
workstation before you proceed to TotalChrom. If the basic Windows 
applications such as Write or Paint cannot print or are too slow, TotalChrom 
or any other application will behave the same. 
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About Installation 

Note: Turnkey systems are shipped with the software installed on the hard drive. Turnkey 
customers should only follow the installation instruction card provided with their system 
and skip all sections in this tutorial that are related to installation. 

Before your computer can collect data, you need to do the following: 

1. Install and configure the computer hardware components. 

2. Install and configure the operating system software. 

3. Install and configure the communication and data collection hardware.  

a) IEEE, serial, or terminal server 

b) 900/NCI Interfaces, 600 Series LINK, or SoftLINK Interfaces and their 
cables 

c) Analog signal cables 

4. Install and configure the TotalChrom software. 

LINK instrument control users may have additional installation steps to prepare third 
party analytical instrumentation for LINK instrument control. In some cases involving 
non-PerkinElmer instruments, you may have to order and install additional boards. 
Make certain you have consulted with your PerkinElmer sales/service representative 
regarding connections to third party vendor instruments so these pre-installation 
requirements can be met. 

If you would like to schedule a service representative to perform this installation, 
contact your local PerkinElmer Service Center for instructions. In the U.S., contact 
the PerkinElmer Customer Support Center at 1-800-762-4000. 
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How to Prepare for Installation 
The time required for installation varies considerably. It depends on whether the 
computer system was purchased from PerkinElmer or someone else and the number 
of instruments you want to connect to the system. 
  
Note:  If you arranged for a PerkinElmer service representative to come on-site to 
install TotalChrom, please remember that they have dedicated this day to getting your 
new system up and running. If they spend time rearranging the lab, searching for 
boxes, or performing other odd jobs that should have been done prior to the visit just 
means less time spent doing what you really need done. 

To get the most out of your day, please complete the following steps in preparation 
for the arrival of our service staff. Check each step as you complete it. Your service 
engineer may review this with you prior to the installation and perhaps have a few 
more suggestions based on your exact purchase. 

 Unpack all equipment, both hardware and software. Compare the items that 
arrived against your sales order to make sure you received all items. 

 Cables that need to be routed through walls, ceilings, etc. should be in place by 
the time of installation. 

 Provide the required bench space for the data system. Make certain there is 
adequate electrical power and that the space is clean, clear, and safe. 

 Place the A/D interfaces and/or LINK modules in the desired locations. 

 Make sure you have the required cables. These include analog lead lines, printer 
cables, IEEE/serial cables, remote lead lines, etc. 

 The detector leads and remote-start leads for your PerkinElmer instruments are 
connected by the PerkinElmer service engineer. For non-PerkinElmer 
instruments, please have these signals connected with twisted pair cabling for 
connection to the 900 series interface. We cannot open up other vendors’ 
equipment. 

 Have available a copy of your computer and/or operating system manuals. Also, 
have the manuals and disks for third party software, detectors, computer, 
expansion cards, and peripheral equipment. 
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 If you purchased LINK instrument control for analytical instruments other than 
PerkinElmer, you may need to make changes to this equipment in advance of 
your installation visit. Your service engineer or sales representative will have 
details on these changes. 

 Backup any unsaved data to a network or backup drive prior to installation. 

 
What If I Install TotalChrom Myself and Need Help 

Your TotalChrom Application Manager’s Guide contains complete installation and 
configuration instructions.  In addition, TotalChrom has contact-sensitive Help files 
(pressing the F1 key) right at your fingertips, as well as Release Notes and Known 
Bugs.  These files contain last minute information that we received from our beta 
testers after manuals were printed. Your question and its resolution may be addressed 
in these files so please consult these files first when you have a problem. 

On a properly configured computer system with Microsoft Windows already 
installed, it takes only a few minutes to install the TotalChrom software.  If you are 
having problems, chances are they have to do with improper configuration of the 
system before you installed TotalChrom.  

If you have problems that are not addressed in the documentation or Release Notes, 
call the TotalChrom Support Specialists in your area (for U.S. and Canada call  
1-800-762-4000).  Phone assistance can generally handle most of these situations, but 
you may want to make sure someone familiar with the computer setup is around if 
computer configuration issues are new to you.  Have all the information about your 
system at hand for the support specialist. 

If you would rather have on-site evaluation of any problem, either now or in the 
future, PerkinElmer has a field service organization prepared to provide on-site 
service for any TotalChrom need. 
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How Can I Be Productive Quickly? 

There is no magic in becoming proficient with pipettes, pH meters, and precision 
balances.  It took practice and training for these tools to become valuable aids in your 
daily life.  TotalChrom is your data-handling tool, and like any other tool in your lab, 
the time spent learning and practicing will make your experience much more 
productive and satisfying. 

Users New to a Chromatography Data System 
If this is your first step up from chart recorders or integrators, take some time to 
understand the concepts of how your new system collects and stores data, how it defines 
a method, and how it permits access to these files for reprocessing data.  The 
TotalChrom User’s Guide provides an overview of these subjects.  Please, review these 
sections before you start to use TotalChrom.  Your job will be much easier when you 
understand what you are trying to accomplish as you go through the keystrokes. 

Make the Most of Your Optional Service Install 
To get the most out of this day, review all of the information in the introductory 
chapters of your TotalChrom User’s Guide BEFORE the PerkinElmer service 
representative installs the system.  Before your service representative leaves, you 
should understand the basics of creating a method, configuring an instrument, and 
collecting data from a run. 

Get Acquainted without Pressure 
It can be frustrating to try to learn a new system while faced with the pressures of 
completing your daily assignments.  Take the time now to schedule an adequate 
phasing in period for new users of your system to get acquainted with the variety of 
ways your data can be collected, integrated, processed, and retrieved.  We think the 
average new user should need at least three days without interruption to become 
familiar with the system.  This includes one full day with Windows, one with 
TotalChrom, and one for making practice injections to reinforce the newly learned 
information. 
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Use the TotalChrom User’s Tutorial 
This manual contains a TotalChrom User’s Tutorial.  Make sure each user completes 
the tutorial exercises before they begin to collect data or process data with the 
software.  The tutorial only takes a few hours and provides a quick overview of basic 
elements of the software.  

Also, DO NOT delete the example files shipped with TotalChrom when you are done 
with the tutorial.  These are helpful for use as troubleshooting aids if needed in the future. 

Learn the Basics First 
TotalChrom has features and flexibility that many labs never realized existed.  We know 
you are anxious to see how TotalChrom integrates that 200-component capillary run and 
whether it can really calibrate on so many levels.  Hold off on this for now. Concentrate 
on the BASICS of the chromatography software before you try the power features. 

 Know where instant HELP is available 

TotalChrom has extensive on-line Help files (F1) for each of the software 
modules. As soon as your software is installed, familiarize yourself with the 
help topics, how to search for help information, and how to look up defini-
tions.  These can be printed out for reference.  In addition, the user manuals 
provide another source of helpful information.  Most operational questions 
can be addressed by using these aids. 

 Method Creation 

Know how to create a basic method and how to use the naming convention 
for files created by your system.  Make sure you understand how to adjust 
the parameters in each method, and what the consequence of that adjustment 
is, without trying to apply those to your application.  All parameters are 
defined in the user’s guide, and we provide example method files with the 
software. 

 Sequences 

Make sure you understand the concept behind sequences for TotalChrom. 
Practice by making and using several sequences with the supplied data files 
to analyze the effect of changing parameters.  The sequence is the main 
blueprint for TotalChrom.  It tells the system what to do next, with what 
method, where the method is located, and what adjustments, if any, are 
necessary to arrive at the final result.  The sequence does exactly what you 
tell it to do, whether it is what you intended or not.  If you are not sure of an 
entry, check the help files or user’s guide rather then making a guess. 
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 Graphics 

TotalChrom graphics routines provide countless ways to view, edit, and 
manipulate data.  The ability to view raw data down to a single sampled data 
point, or to select a small portion of the entire chromatogram for expansion, 
is probably foreign to former users of chart recorders or simple integrators. 
Use the sample data files with this tutorial to practice the variety of graphics 
options your package allows.  These files can be restored from your 
TotalChrom CD so you can experiment with them to your heart’s content.  It 
is best to try all those features now and become proficient with the test data, 
so when the real data comes along, you will be prepared to work with it 
quickly.  It is a good idea to copy these over after each practice session so 
the next user has fresh files when they start learning. 

Collect Practice Runs 
Prepare several identical standards to use to learn the data acquisition portion of your 
software package.  Do not be concerned at this point with internal or external quanti-
tation or calibration.  Set up your method for a simple area percent analysis, and get 
comfortable with the process of downloading to the interface, integration, optimizing 
for noise and area thresholds, and the effects of varying sampling rates.  This is a 
good time to practice setting up Baseline Timed Events to see how each event affects 
integration on a known sample.  Make sure you are comfortable with your 
understanding of how data, method, and sequence files are edited, saved, and named 
before moving on. 

Now prepare a rack of samples for external standard analysis.  After making your 
standard injection(s), set up your method for external standard analysis, name your 
components, and calibrate your method following the instructions in the user’s guide. 
Inject controls until you are comfortable with your results.  Repeat the process with 
an internal standard run. 

When you are comfortable making practice runs and manipulating data, you are ready 
to move on to your specific application.  Print out the method and sequence files from 
a successful practice run to serve as hard copy templates.  Mark the changes you need 
to make for your application on the printouts.  You will find that the screen edits 
proceed more quickly, and you are not likely to forget anything.  Clear any unwanted 
data and method files from the system so it is not cluttered with unnecessary files. 
(You might like to save some of those practice files on disk to serve as default files 
for your application.) 
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Register for a User’s Class 
Most labs will have a few users that will quickly understand TotalChrom.  As the first 
month of TotalChrom implementation nears completion, arrange to have one or more 
users participate in a product-training course.  Do not sign up for the class before you 
have at least 30 days on the system.  Our technical trainers have seen new users take 
the class before the installation of TotalChrom, and they just do not have the 
experience with the software to get everything out of the class they would have if they 
had waited.  

In the U.S., you can request a Technical Training brochure, current schedule, or class 
registration by calling the PerkinElmer Technical Training Center at 1-800-762-4000. 
Outside the U.S., contact your PerkinElmer representative for local information. 

PerkinElmer Product Specialists 
The PerkinElmer field organization has a staff of highly skilled local specialists in 
GC, LC, and data handling products who are available for on-site assistance with any 
application need your lab might have.  These specialists draw on many years of 
experience in laboratory environments just like yours.  If you would like to use these 
resources, feel free to contact your PerkinElmer sales staff. In the U.S., call the Sales 
Administration staff at 1-800-762-4000. 
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What If I Have Problems? 

Try This First 
Troubleshooting system and software problems can be a real challenge to users who 
have extensive experience in computer systems, networks, and communications.  For 
those of us who have much less experience, and just want to get our samples out the 
door, the complexity and proliferation of computerized data handling systems and 
software may seem a bit overwhelming. 

Whether you have a single, stand-alone TotalChrom Workstation, or a powerful 
network composed of 30 licenses of TotalChrom Client/Server sharing data with a 
LIMS system, the basics of what to do when a problem occurs are pretty much the 
same.  Approaching a system problem methodically BEFORE contacting software 
support or service personnel can save you time and money.  For example, start by 
answering the following questions: 

 Does your system at least meet the MINIMUM requirements as stated in the 
TotalChrom Release Notes? 

If it does not, you WILL have problems.  These truly are the basic 
requirements for the version of software. 

 Did you check the documentation? 

Check the section of your documentation that explains the commands and 
procedures you are using to make sure you are operating the software 
correctly.  It may be that what you are trying to do simply cannot be done, or 
perhaps the feature you are thinking of is actually located in another module 
of the software.  

Do not forget the HELP files (by pressing the F1 key) right at your 
fingertips, as well as the Release Notes and Known Bugs files available from 
your TotalChrom program group.  These files contain last minute informa-
tion we received from our beta testers after manuals were printed.  Your 
question and its resolution may be right here. 
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 Have you performed good housekeeping procedures on your system? 

Users with MIS staffs overseeing their system needs probably have 
established system housekeeping procedures.  However, if you also pull 
double duty as the keeper of your computer, you will need to perform 
weekly maintenance.  This includes disk defragmentation, file backup, and 
removal of any files you no longer need (for example; error log files).  Data 
acquisition systems such as TotalChrom are incredibly disk intensive, so the 
cleaner your hard drive, the faster your system.  

Also check your system’s TEMP directory to make sure it’s not cluttered 
with  .TMP files you no longer need.  Use a general diagnostics utility once 
each month to check all other components of the system for signs of failure.  
Do not forget to check those cables as well to make sure they are seated 
correctly and are not worn from moving equipment around.  A little 
preventative action now will help ensure that your system is in top shape. 

 Are you encountering specific error messages? 

“I think it said something like . . .” may not be much help to people trying to 
identify what is wrong.  Determine whether those errors are coming from 
your computer, DOS, Windows, or the chromatography software, and write 
down or make a screen print of exactly what the message says.  Each of 
these error messages should be described in the appropriate manuals 
supplied with your system or software; this description will help direct you 
to the problem.  

TotalChrom has a log directory that stores error messages encountered by 
TotalChrom.  Your TotalChrom Support Specialists may request that you 
send these log files for further analysis.  We recommend that you keep at 
least a week’s worth of these files on hand.  This will help us to determine if 
the system has a history of repeated error messages. 

Note: LINK customers should be aware that any instrument control errors displayed 
in TotalChrom are actually returned from the analytical instrument.  They are usually 
explained in the manual that comes with your instrument (GC or LC) and not in the 
TotalChrom or LINK documentation. 

 Is the problem repeatable, or can it be duplicated on another system? 

Fundamental to solving software and hardware mysteries is knowing exactly 
when they occur and what the conditions are that lead to their occurrence. 

a) If you have multiple TotalChrom systems available, check whether the 
problem occurs on other systems as well.  If it does not, this may point to a 
system problem and will help focus the troubleshooting effort. 
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b) Can the problem be duplicated with the test data files that came with the 
system?  If not, this may point to a problem with the new files you created. 

c) Are you on a network?  See if the problem still exists when you are 
disconnected from the network to rule out a network problem. 

Remember that system operation is dependent on everything communicating 
in harmony. In the case of data acquisition software, the timing and number 
of these communications are incredibly complex and demanding on the 
system, involving both internal (computer, disk drive, printer) and external 
(instrument control, IEEE and serial communications) devices.  

Occasionally, something interferes with this communication and simply 
cannot be traced.  Perhaps it is the result of electrical disturbances in your 
lines from voltage brownouts or surges; a strong magnetic field created by 
equipment in the next lab; a loose connection; a failing piece of hardware; or 
just the night cleaning crew plugging their vacuum cleaners into the same 
circuit as the system analyzing your overnight run.  If the problem seems to 
have disappeared, make a note of it just in case, but you can generally 
proceed without concern.  

 What has changed since the problem started? 

“It was working fine yesterday. No one touched anything...really!” 

Software doesn’t just break.  Ask everyone who uses or maintains your 
system whether anything has been done to it that you do not know about.  

• Has someone installed a new software package or driver that might be 
interfering?   

• Has someone on the night shift altered the TotalChrom or Windows 
configuration file since you last operated the system? 

• Has someone changed my directory permissions? 

• Have my user and/or TotalChrom process account passwords expired?   

It is not impossible that a software file gets corrupted somehow, but before 
you reinstall the software, check out the obvious culprits first.  These can 
often be diagnosed quickly by rebooting your system with a blank system 
disk containing basic autoexec and config files.  If the problem disappears 
with the use of this system disk, look to the startup files for a potential 
conflict. 

Hardware on the other hand does break.  Even worse, it can break with an 
insidious style that drives users and support specialists crazy.  It can work 
fine one day and create havoc the next.  Often we cannot catch this until it 
finally breaks for good.  Every system should have a good diagnostic 
software tool that puts its hardware through the paces so hardware faults can 
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be determined or ruled out.  Do not forget the obvious here, or maybe not so 
obvious, too.  

• Did someone move equipment? If so are the cables seated properly?  

• Is your hard disk full?  

• Is your printer connected and turned on?  

• Did someone wrap that extra length of cable around the base of an old 
centrifuge to clean up the lab counter top? 

More than half of all the calls to Software Support have nothing to do with 
the actual TotalChrom software, but are the result of problems with the 
operating system (DOS), Windows, network configuration, hardware system 
configuration, or device drivers for printers and other devices. 

Internet Support Help 
Additional support information is provided on the PerkinElmer web site:  

http://las.perkinelmer.com/content/onesource/index.html 

This service provides an economical vehicle for users to get the latest information 
regarding product support issues. 

When All Else Fails and You Need Help 
If you tried all of the above and still need help or advice, it is time to contact us. 
PerkinElmer has several options in place for assistance with PerkinElmer software 
and hardware. Your local sales or service representative will provide you with 
information regarding how to access providers of assistance in your particular 
country. 

If your shipment contains a companion pamphlet covering software support options in 
your country, review that pamphlet to see what options are available to you BEFORE 
that first question or problem comes up. Keep this information along with user 
manuals, software media, and the license agreement in a safe, accessible location. 

Placing the Call . . . 
When you need to talk to a technical representative, the following list can help you 
get the most from that conversation. Like you, we want to resolve your call as quickly 
as possible. 

 Have the phone within reach of the system. 

We may have you try several things on your system to determine the source 
of your problem.  Or, we may have you go over the steps you are having 

http://las.perkinelmer.com/content/onesource/index.html
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problems with, keystroke by keystroke, as we duplicate them on the other 
side. 

 Have your Serial Number, Software Licenses and/or your original software 
media available. 

You will need these to access most centralized phone support programs and 
services. 

 Have your computer hardware, Windows, and software manuals available. 

We may need to refer you to these for additional information. 

 Know the version and service packs of all relevant software packages. 

 Record any error messages exactly as they appear on the system. 

Make sure you can state exactly where errors occurred and what steps are 
required to reproduce them. 

 Have available the make and model numbers of your computer and 
associated hardware. 

 Have the end user make the call. 

Note: DO NOT make calls on behalf of the end user having the problem unless you 
fully understand both the problem and the system. These calls are seldom resolved 
quickly because of the unfamiliarity of the caller with the situation. 

Contacting PerkinElmer 

 US & Canada Customers Outside the US 

Customer Support Phone:  (800) 762-4000 Local PerkinElmer Sales Office 
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What Happens to My Problem or Suggestion? 
As problems and suggestions regarding software operation, functionality, features, or 
documentation are reported by registered users, Software Support begins a software 
investigation.  This investigation starts with a search for whether the issue has been 
previously reported. If it has, you will be notified of the resolution.  If a problem has 
not been reported, Software Support will attempt to duplicate your experience on 
standard supported computer systems sold by PerkinElmer. 

If the problem can be duplicated by Software Support, and it resides in our software, a 
Software Investigation Report (SIR) will be prepared and forwarded to the PerkinElmer 
Product Department, as well as, Software Development for further action. 

What If My Problem Can’t Be Resolved Immediately? 
Occasionally, everything we do in a remote troubleshooting process comes up empty, 
and we need to do some research with the product, your system and data, our 
engineering staff, or a third party.  If we cannot reproduce the problem, we will assist 
you with as much user education, system configuration troubleshooting, and hardware 
troubleshooting as is possible from a remote location.  We will continue until the 
problem is resolved or until we can advise you what we think is necessary for it to be 
resolved. 

In cases where we cannot make the symptoms appear as described, we may need to 
get additional information from you regarding the system you are working on and its 
setup and configuration.  We may also need verification that the software is installed 
according to product documentation.  This process may require eliminating 
potentially interfering third party software or hardware in an effort to return the 
product to a functioning state.  Sometimes this can be a tedious process over the 
phone, and as Murphy’s Law dictates, this always seems to occur when you have to 
get those 200 samples out the door.  Please be patient.  You are our eyes, ears, and 
hands in these situations, and we need you.  

If the problem requires on-site assistance, or is the result of operation of the software 
on non-standard or non-supported hardware or system configurations, Software 
Support may make several suggestions.  One may be to request you involve the local 
PerkinElmer Service office and get a service engineer on site who can help us evalu-
ate the situation first hand.  Software Support will work with the local office to assist 
in the effort. 
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Upgrades and Updates? 

Your PerkinElmer purchase grants the right to use the software version that was 
shipped to you.  Like a book, audiotape, or videotape of your favorite movie, the 
media is yours, but the content remains the property of PerkinElmer.  In the software 
business, vendors convey this “right to use” with a software license. 

The analogy stops here.  Where the development costs of a good book or movie end 
with its release, the development costs of good software continue as the product 
expands to new operating systems, new applications, and incorporates new ideas from 
users.  If existing license holders want to take advantage of the new features and 
fixes, they can do so economically by using the vendor’s software update and upgrade 
program. In essence, these programs re-license the existing product users, giving them 
the “right to use” the new version. 

The terms Upgrade and Update are often used interchangeably. In reality they 
represent distinct classes of software offerings to existing users of the product. 

What Is an Upgrade? 
There are two types of upgrades —Product Upgrades and Software Upgrades. 

Product Upgrades exist so customers have an option to buy into the PerkinElmer line 
of products with minimal features, then migrate up to more feature-packed products at 
a reduced price as conditions permit.  Upgrading is usually associated with the 
strategic needs of a growing lab as determined by the lab manager in consultation 
with a PerkinElmer sales engineer.  

For example, you may have bought a Product Upgrade to TotalChrom from our 
Turbochrom Professional chromatography software. We only mention product 
upgrades here to help distinguish them from software upgrades. 

Software Upgrades are major releases of an established product that incorporate 
significant enhancements to the software, or take advantage of a major new platform, 
operating system, or user interface. TotalChrom v6.2 is a Software Upgrade from the 
Turbochrom Professional v4 revision.  
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How Is This Different from a Software Update? 
Minor enhancements, feature changes, and/or problem fixes that come about as a 
result of users interacting with the software are periodically made to the product code. 
As these enhancements and fixes accumulate and pass testing protocol, we may issue 
a Software Update.  

An update does not have the major feature enhancements usually associated with an 
upgrade, but usually has a host of improvements and fixes that help make your life 
easier.  An update revision is reflected by a change in the second digit of the version 
code (for example; TotalChrom v6.2 to TotalChrom v6.x). 

What Is PerkinElmer’s Policy Regarding Software Upgrades 
and Updates? 

Software Upgrades and Updates will be announced in a letter to registered end users. 
This letter will advise you of the procedure to follow and what costs are involved to 
get the new license.  If you are not registered, you will not receive notice of these 
new products. 

As a general rule, it is beneficial for users to move to the current shipping release of 
the software.  Aside from the fact that the current release always contains the latest in 
enhancements and fixes requested from users, old releases become harder and harder 
to support as they are replaced.  In general, centralized phone support resources 
support the LAST TWO minor revision series. Assistance on versions more than two 
revisions old is generally confined to existing information in our database. 

What Is a Maintenance Release? 
As you may know, software development is a dynamic process.  While you may be 
using v1.1.1, Software Support may be testing v1.1.2, while Software Quality 
Assurance may be testing v1.1.3, while Software Development may be coding v1.1.4. 
If Software Support does not release v1.1.2, or if v1.1.3 never makes it past SQA 
testing, you may never see these versions.  You may think we skipped a version or at 
least skipped telling you about it, but actually it may have never have made it to 
release.  

However, if v1.1.2 was approved for release, we may have issued a Maintenance 
Release (MR). A MR is identified by a change in the third digit of the software 
revision code (for example; v6.1.0 to v6.1.2).  MRs generally contain fixes only.  No 
documentation changes are made. 

MR availability and ordering information can be located in the software support area 
of our web site ( http://las.perkinelmer.com/ ). You can also get this information from 
your local software support representative.  Support will only ship MRs to users 
who are registered for the version of the product for which the MR was created.  

http://las.perkinelmer.com/
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Supplemental Maintenance Releases 
Occasionally, software engineering may release a maintenance disk containing a few 
fixes to a specific program module that has limited value to the entire user base. 
Supplemental maintenance releases (SMRs) are only released when a few problems 
can be fixed without affecting other modules in the software. SMR code will be made 
available on the PerkinElmer web site for direct access by users. 

Summary 
We hope this introduction has been helpful.  All of us in Software Support want your 
experiences with our products and the entire PerkinElmer team to be successful for 
many years.  Please let us know how we can be of more help, whether it is a feature 
you would like to see in the software, or a support program you would like to see us 
implement in the future. 
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Tutorial Introduction 

About the TotalChrom Tutorial 
The TotalChrom Tutorial is designed for your interactive use with TotalChrom to 
help you get started by performing basic tasks. To familiarize you with this process, 
the tutorial leads you through the following series of procedures that are organized to 
illustrate your typical workflow: 

 Creating a quick method 

A method is a collection of parameters that determine how TotalChrom 
acquires and analyzes data. 

A quick method is a method that defines only those parameters that are 
essential for acquiring data. 

 Acquiring data with that method 

 Optimizing the method 

Optimizing means adjusting method parameters to provide the best analysis 
of the raw data. 

 Creating a report format file for printing the results of the analysis 

A report format file contains the specifications for the analysis report and 
some of the report’s formatting characteristics. 

 Building a sequence that utilizes the optimized method 

A sequence is a collection of one or more rows of information that defines 
analysis cycles. The sequence that you create controls how data is acquired, 
analyzed, and/or reprocessed. 

 Reprocessing stored data with that sequence 

Reprocessing is the reanalysis of stored data. 

This tutorial does not cover every feature in TotalChrom.  It follows a specific path, 
while TotalChrom’s flexibility and the variety of instruments it supports offer many 
paths. 

For a complete description of all TotalChrom functions and operations, see the 
TotalChrom User’s Guide. 
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For electronic information, TotalChrom has online help that you can access at any 
time. For information about online help, see The Help System in Chapter 1 of the 
TotalChrom User’s Guide. 

Before You Begin 
It may take between 1 and 1-1/4 hours to complete the entire tutorial. If necessary, 
you can break it into two sessions: Part 1 will take between 20 and 30 minutes, and 
Part 2 will take between 35 and 45 minutes. 

The tutorial assumes that TotalChrom has been installed as described in the 
Application Manager’s Guide.  It also assumes that you know how to operate your 
chromatograph and that you know the basics of using Microsoft Windows. 

For an explanation of the features in Microsoft Windows that you need to know in 
order to run TotalChrom, see Chapter 2 in the Application Manager’s Guide. 

Checklist 
Complete the following preparations before you start the tutorial: 

 Make sure that at least one interface (Model 900, Model 600 LINK, SoftLINK or 
NCI) is connected to a chromatograph. 

 Prepare a single, known standard with a relatively short run time. 

 Turn on your printer and check the paper supply. 

 Ensure that Windows is running. 

 In the Windows Explorer, you may want to create a training directory on your 
local drive. For example, C:\PenExe\TcWS\Ver6.3.0\tutorial.  

 Ensure that the above directory has RWXD privileges for both the TCProcess 
account as well as the user’s logon account. 

 Copy the Examples directory (located in C:\PenExe\TcWS\Ver6.3.0 or a similar 
directory) to the above training directory.  These files will be used throughout the 
training exercise. 
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Other Helpful Hints 
• Follow the directory and file name instructions carefully. You will save everything 

in the C:\PenExe\…...\tutorial directory then delete all the files after you have 
completed the tutorial. 

• When you collect data in Part 1 of the tutorial, you must provide values that are 
appropriate for the analysis that you are performing and for the equipment you 
are using. 

• The defaults on your system may be different from what the tutorial describes or 
illustrates. The tutorial may direct you to enter or select something that is already 
present or selected, or where your instruments do not provide a choice. 

• If there are no directions for a parameter, just leave it as is. 

• When there are multiple ways to do something, the choices are listed and 
separated by OR. 

 

We are ready to begin the interactive part of the tutorial. 
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Tutorial Part 1 

The TotalChrom Navigator 
You access the various functions in TotalChrom from the Navigator window. The 
most convenient way to start the Navigator is from the “TCWS_Links” windows (or 
TCCS_Links for TotalChrom Client/Server), which is created during installation. 

 To open the Navigator window: 

1. Click the Start button and point to Programs, then click TotalChrom 
Workstation Ver6.3 to display the Links window. Double-click on the 
TCNav icon in this window. 

 
The Logon dialog box appears: 

 

Note: You must logon to a user account that has manager permissions enabled. If you 
have any questions, consult your system manager. 
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2. Enter your Logon User Name and your Password. Then choose OK. 

The Navigator window appears: 

 

The Navigator window is a graphical representation of the major functions in 
TotalChrom. The Navigator has four main areas: 

 Title Bar and Menu Bar on the top. 

 Instrument Selection Panel on the left. 

 Function Buttons in the central part of the screen.   

Note: This screen shows that the TCPublisher reporting option was selected.  To 
change to Review and Approve, select TotalChrom Review & Approve in the 
Reporting Options dialog. This is displayed by selecting Reporting from the 
Build>Configuration>User> menu. 

 Status Bar at the bottom of the window. 

We will use the instrument selection panel and several function buttons in the tutorial. 

Menu Bar

Instrument 
Selection 

Panel

Status Bar

Title Bar
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Collecting Your First Data File 
In this part of the tutorial you will: 

 Use Quick Start 

 Build a quick method by designating instrument parameters 

 Build a vial list 

 Acquire data 

 Adjust the real-time plot of the data points as they are acquired 

 Review the printed output 

 

Using Quick Start to Acquire Data 
The Quick Start option allows you to collect data without developing a compre-
hensive method. With Quick Start, you enter only the parameters that are essential for 
performing a run. 

Quick Start is helpful when you are first starting to use TotalChrom, if you are 
performing a “survey” run on a type of sample that you have not analyzed before, or 
when you are developing instrument settings for an analysis. 

 To begin the setup procedure to acquire data: 

1. Select the instrument you want to use for data collection from the instrument 
selection panel in the Navigator (you will use this instrument throughout the 
entire tutorial). 
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2. Click on the Setup button in the Navigator. 

 

The Setup Instrument dialog box appears. 

3. In the Setup Instrument dialog box, select Quick start as the Setup Type. 

 

4. Click the folder icon next to the Raw File Path text box as shown above. 
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The TotalChrom Path-Select dialog box appears: 

 

5. In the TotalChrom Path-Select dialog box, select the full-path 
“C:\penexe\…..\examples” directory by double-clicking until the complete 
Path is displayed above the list of directories. Choose OK. 

6. Perform the same procedure for the Result File Path text box.  

7. To enter a Base File Name, click on the button to the right of the text box. 

   
The Default Base Names dialog box appears. 
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8. In the Default Base Names dialog box, select NONE for the Separator and 
type TEST into the Base File Name field. 

 

This dialog discusses Tokenized filenames (a new feature to version 6.2).  Please 
consult your User’s Guide for a more detailed description about this option. 

All files related to this quick method that we are creating — raw, result, 
method, and sequence files — will use this base file name. 

TotalChrom will append a three-digit run or cycle number to this name  
(based on the number of digits specified for the suffix under the Default 
Base Names dialog) when it creates the raw and result file names. 

9. Click OK to close Default Base Names dialog box. 

10. Leave the “Suppress processing” and “Suppress reports/plots” check boxes 
unchecked as shown in the above screen. 

We want to process the data file immediately after it is collected, and we 
want a printed report and plot at the end of the run. 

11. Do not click the OK button yet. 

You have completed the entries in the Setup dialog box. The next 
step is to build a quick method. 

For additional information on the Setup dialog box, see “Acquiring and Viewing 
Data” in Chapter 12 of the TotalChrom User’s Guide. 
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Building a Quick Method 
The Quick Method button in the Setup dialog box opens the Quick Method Editor, 
which is a limited version of the Method Editor. You can access the instrument and 
processing parameters in the Quick Method Editor.  

The Quick Method button also opens a series of dialog boxes in which you set the 
instrument parameters. In each of these dialog boxes you will select options and enter 
values that are appropriate for the analysis you are performing and for the instrument 
you selected.  

 To build a quick method: 

1. In the Setup Instrument dialog box, click on the button to the left of “Quick 
method.”  

 

The Quick Method Editor window opens, with the Documentation dialog box. 
This is the first in the series of dialog boxes that will be displayed 
automatically.  

2. You may enter any descriptive information about the method in this window 
or click on NEXT to leave it blank.  Do Not Select Audit Trail. 

The next window to appear is the Instrument Notes dialog box.  
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3. You may enter any instrument specific information into this dialog or choose 
from the template drop-down menu for one of the pre-designed instrument 
templates. You may also choose to leave it blank, if so, click NEXT to display 
the Data Acquisition dialog box. 

The information displayed on the Data Channels tab varies depending on the 
instrument you selected at the beginning of this procedure. This is shown in 
the following two figures:  

 

Data Channels tab for a 900/NCI Series Interface 

 

Data Channels tab for a LINK-controlled instrument 
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4. Under Data Channel, select the channel (A, B, or Dual) that matches the way 
your detector output is connected to the interface. 

5. For a LINK-controlled instrument, select a data source from the drop-down 
list (some instruments do not provide a choice). 

OR 

For a 900/NCI Series Interface, select the required voltage range that 
corresponds to the output from your detector.  

6. Select a Set Data Rate option. 

 
If you know how wide your narrowest peak is at its baseline, select “By peak 
width at Base” and enter the number of seconds in the text box. TotalChrom 
will use this to calculate the optimum sampling rate for that peak. 

OR 

Select “By sampling rate” and select or enter a rate (depending on the 
instrument). 

Suggested sampling rates are: 

Capillary GC = 20 pts/sec 
HPLC or IC =  5 pts/sec 
Packed column GC =  2 pts/sec 



Tutorial Part 1 

 33 

7. We want to save the complete run rather than using delay and run times to 
store only a part of it. 

For a LINK-controlled instrument, select “Store all data from run.” 

OR 

For a 900/NCI Series Interface, leave “Delay time” set to 0, and enter a 
“Run time” that corresponds to the length of your run. 

 

8. Choose NEXT to display the first in a series of dialog boxes for the 
instrument you selected. 

9. Complete each series of dialog boxes using the appropriate values for your 
sample and equipment. (Since the people following this tutorial will be using 
a variety of equipment, we cannot anticipate the specific entries.) 

Note: Press F1 when a dialog box is open to display the online Help for that box. 

The dialog boxes displayed in the rest of this series depend on the instrument 
you selected and on the instrument modules you configured. We will not 
enter any processing parameters for this quick method. It is often easier to 
set these parameters after the fact using the Graphic Method Editor. We will 
use that function in Part 2 of the tutorial. 

When you reach the Components dialog box, which is the last screen in the 
series for all instrument types, click on Finish. 
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When you complete Quick Method dialog boxes, the Method Summary, 
Component List, or a combination of the two screens will be displayed 
showing the initial parameters you have set. 

 

 To save the Quick Method: 

1. Choose Save from the File menu to save the method. 

The quick method is saved using the base file name that you entered in the 
Setup dialog box, plus the .MTH extension (for example, TEST.MTH in this 
tutorial). 

2. Choose Exit from the File menu to return to the Setup Instrument dialog box. 

• For more information on instrument parameters, see Chapter 6, 
“Developing Instrument Parameters in the Method”, in the TotalChrom 
User’s Guide. 

• For more information about quick methods, see “Using Quick Method” 
in Chapter 12 of the TotalChrom User’s Guide. 

Although it is not required for all instrument configurations, the next task we 
will perform in this tutorial is building a vial list to specify the samples to be 
injected. 
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Building a Vial List 
You can build a vial list for any instrument, but it is only required if you are using a 
LINK-controlled autosampler. We will build a vial list in order to become familiar 
with that part of TotalChrom. 

The Vial List button in the Setup Instrument dialog box opens a limited version of the 
Sequence Editor. In addition to entering vial numbers, you can also enter the sample 
name, number, rack number (if applicable), and injection site (if you are using a 
LINK-controlled GC). There are other columns that are not used in a normal Quick 
Start setup. 

 To build a vial list: 

1. In the Setup Instrument dialog box, click on the “Vial list” button. 

 

This opens the Vial List window with the Sequence Information window: 
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2. If you are using a LINK-controlled LC autosampler, you must indicate the 
tray type. 

a. Choose Global Parameters from the Change menu to display the Global 
Parameters dialog box. 

 

b. Select the type of tray installed in your autosampler from the Tray drop-
down list. 

c. Click on OK. 

3. In the Sequence Information window, select the first cell in the Vial column 
by clicking in it. 

 

4. For a LINK-controlled autosampler, enter the vial number where your 
sample is located. 

For all other instrument configurations, leave the default entry. 

5. Do not enter any more vials. Instead, delete the remaining rows, 2 through 5. 
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6. Highlight row 2 then Display the Edit menu. 

Notice that you have several choices for manipulating rows in the 
spreadsheet and that each has a keyboard shortcut. 

 

7. Choose Delete from the Edit menu. Row 2 is deleted and rows 3-5 move up 
in the spreadsheet. 

8. Delete the remaining 3 rows in the same manner. 

You have completed the vial list and are ready to save it and start the run. 

 To save the vial list: 

1. Choose Save from the File menu. 

The vial list is saved as a sequence (of 1 cycle in this case), using the base 
file name you entered in the Setup dialog box, plus the .SEQ extension 
(TEST.SEQ in this tutorial). 

2. Choose Exit from the File menu to close the vial list window and return to 
the Setup Instrument dialog box. 

3. Choose OK in the Setup Instrument dialog box to initialize the instrument 
and return to the Navigator. 

For more information, see “Building a Vial List” in Chapter 12 of the 
TotalChrom User’s Guide. 

You have now completed everything you need to acquire data. 

You are ready to inject your standard and acquire data. 
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Injecting your Standard and Acquiring Data 
Now that you have completed the Setup procedure and the instrument is initialized, the 
text in the Status box in the Navigator indicates that the instrument is Ready. (The other 
items displayed in the Status box depend on the type of instrument that you are using.) 

 

 To start data acquisition: 

The way you start the run depends on your instruments and how they are connected. 

• For a LINK-controlled autosampler, click on the Run button in the Navigator 
then choose Start Run from the menu. 

 

OR 

• For an A/D connected to a chromatograph with an autosampler, the A/D 
may be wired to start sampling when the autosampler injects. In this case, 
simply start your instrument. 

OR 

• For an instrument without an autosampler, inject your standard into the 
chromatograph. If your chromatograph is connected to a LINK, press start 
on the chromatograph. If your chromatograph is connected to an A/D, you 
may have to press the start button on its front panel. 

When the run begins, the Status box indicates that the instrument is active 
and sampling. 

 
For more information, see “Controlling Data Acquisition” in Chapter 12 of 
the TotalChrom User’s Guide. 
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Viewing the Real-Time Plot 
The Real-Time Plot button lets you display a plot of the data as it is being acquired by 
an interface. 

 To open the Real-Time Plot window: 

• In the Navigator, click on the Real-Time Plot button to open the Real-Time 
Plot window. 

 
The parameters for the initial display come from the Real-Time Plot Scale 
dialog box that you completed in the quick method by accepting its defaults. 

There are a number of things that you can do from the Real-Time Plot 
window. We will experiment with changing the display from the Options 
menu. Display changes are temporary, affecting the current display only; 
they do not change the settings in the method and they do not affect data 
acquisition. 
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Zooming In on the Real-Time Plot 
The Zoom In and Zoom Out commands in the Options menu of the Real-Time Plot 
window let you enlarge and reduce your view of the real-time plot as the data points 
are being collected. 

Zoom In halves the value of the voltage axis, thereby enlarging the plotted peaks and 
revealing more detail about the incoming data. Zoom Out doubles that value, reducing 
the size of the plotted peaks. 

 To zoom in and out of the real-time plot: 

1. In the Real-Time Plot window, display the Options menu. 

 

2. Choose Zoom In (for the channel you want to view) to enlarge the plot. 

3. Choose Zoom In again until the view is as large as you want it to be. 

4. Choose Zoom Out until the plot view is restored to its original size. 

Note: You can zoom in and out without displaying the Options menu by using the 
keyboard shortcuts F5 and F6 while the real-time plot is displayed. 

Zoom In and Zoom Out act on the full-scale value for the voltage axis, 
halving and doubling it respectively. Our next step is to change the voltage 
axis value explicitly from the Rescale dialog box. 
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Rescaling a Plot 
The Rescale command in the Options menu lets you change the scaling parameters of 
the plot while data are being collected. 

 To change the scaling parameters in the real-time plot: 

1. In the Real-Time Plot window, choose Rescale from the Options menu to 
open the Rescale dialog box. 

 

Under Voltage Axis, the value for Full Scale is the value that is currently 
being used for the display. That value may be (a) from the method, (b) as 
altered by zooming, or (c) as you specifically changed it in this dialog box. 

2. Double the value for Full Scale, then choose OK.  

The plot is redisplayed with a new Y-axis scale that reduces the displayed 
peak size by one half (the same effect as zooming out). 

You can continue to experiment with the Real-Time Plot display while the 
run is finishing. 

3. Allow the run to finish and the data to be processed. 

OR 

If the run is not yet complete and you are ready to continue with the tutorial, 
you can stop the run by selecting Stop Run from the Run menu. It would be 
helpful if at least one peak has been detected. 

4. To close the Real-Time Plot window, choose Exit from the Instrument menu 
to return to the Navigator. 

When the run is completed (or stopped), the default report and annotated 
replot will be printed. 

For more information, see “Viewing Real-Time Plots” in Chapter 12 of the 
TotalChrom User’s Guide. 
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Once you have acquired a data file, you can use the stored data file to set up better 
processing parameters. You do this by using the Graphic Method Editor. We will use 
this function in Part 2 of the tutorial. 

First, let’s look at the printed output from our data analysis. 

The Default Report and Plot 
If your printer was attached and turned on, a report and plot were printed after data 
analysis. Let’s take a quick look at these printouts. Both were formatted using default 
settings. 

The top part of the report contains information from the method, such as data channel 
and run time. These items, and the information on the report itself, are configurable. 
We will customize a report in Part 2 of the tutorial. 

The plot is also headed by identifying information. The way the plot is printed is also 
configurable in the method (it has no relationship to the scale of the real-time plot.) 

Note: We will not reuse any of the files created in this part of the tutorial.  In Part 2 
we will use sample files that are shipped with TotalChrom. 

You have completed Part 1 of the TotalChrom tutorial. 

• You need another 35 to 45 minutes to go through Part 2, which you 
should complete in one session. 

• If necessary, you can stop here and continue at another time. 

Note: Every step in the rest of the tutorial is built on, and is a continuation of, the 
previous step. Therefore, you need to complete it as a whole. 
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Tutorial Part 2 

Optimizing a Method Using Graphic Editing 
In this part of the tutorial you will use some of the basic features of the Graphic 
Method Editor to: 

 Change the plot display 

 Adjust peak detection parameters 

 Create a component list 

A method contains the parameters that determine how TotalChrom analyzes raw data. 
With the Graphic Method Editor, you can adjust those method parameters and see the 
effects of the change immediately. 

Viewing the data in graphic form helps you determine if peaks are being detected 
correctly, if baselines are being placed properly, and if expected retention times and 
search windows for components are identifying peaks accurately. 

To edit a method in the Graphic Method Editor, you specify a raw data file that 
represents a chromatogram of the analysis that you want to optimize. TotalChrom 
processes the raw data with the method that is referenced in the raw file header and 
then displays the chromatogram, showing the resulting integration and peak 
identification. 

For more information about the Graphic Method Editor, see Chapter 10 in the 
TotalChrom User’s Guide. 
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Opening the Graphic Method Editor 
We will start by opening the Graphic Method Editor and displaying a chromatogram 
that has already been optimized. 

Note:  Since we need to work with something known in this part of the tutorial, we 
will not use the quick method and result file from Part 1. 

 To open the Graphic Method Editor and load a file: 

1. In the Navigator, click on the Graphic Edit button. 

 
The Graphic Method Editor window opens as well as a file selection dialog 
box that displays a list of raw data files. 

 
2. Select the “Examples” directory from the TotalChrom Quick Paths drop-

down list or from the list of directories. 
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3. From the list of files in the “Examples” directory, select halo003.raw. 

 
4. Choose Open. 

The default display shows a working chromatogram in the main work area of 
the window and a reference chromatogram above it. The name of the raw 
data file appears in the status bar and the name of the method used to process 
the data appears in the title bar. 
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In the following steps, we will explore some of the ways that you can 
optimize a method to achieve this kind of result. 

Note:  For this tutorial, we will create an unsatisfactory method so that we have 
something to optimize. The step below is for that purpose; it will most likely not be 
your normal procedure. 

 To reset the method parameters to defaults: 

• Choose New from the File menu. 

The default method parameters are applied to the halo003.raw file. 

 

Before we change any of the method parameters, we will experiment with changing 
the way the chromatographic information is displayed. 
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Changing the Plot Display 
There are several ways to change the plot display. We will experiment with two of 
them in this part of the tutorial. 

You can use the mouse to change the display by highlighting the area of the plot that 
you want to expand. We will do this from the reference chromatogram; you can also 
do it from the working chromatogram. 

 To select and manipulate a portion of the reference chromatogram: 

1. Select a part of the reference chromatogram as shown in the example below 
by holding down the left mouse button and dragging the mouse to outline the 
area. 

 

2. Release the mouse button. 

The working chromatogram expands to match the highlighted area in the 
reference chromatogram. 

Notice that the working chromatogram matches the highlighted area exactly, 
so that any peak whose full height you do not select is truncated. 

3. Move the cursor (arrow) into the highlighted area in the reference 
chromatogram. 
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The mouse pointer changes to a thick crosshair cursor. This indicates that 
you may move the selection rectangle. 

 
4. Hold down the left mouse button and drag the selection rectangle to another 

part of the reference chromatogram. 

5. Release the mouse button. 

The working chromatogram is updated to show the new highlighted area in 
the reference chromatogram. 

6. Position the cursor anywhere in the working chromatogram, then click the 
right button to restore the chromatogram to its original scale. 
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If you moved the rectangle more than once, click the right mouse button 
until the chromatogram returns to its original scale. A message will be 
displayed when there are no more expansions. 

 

Next we will change the display by directly altering the values that 
define it. We want to see only the area before the first peak to 
have a detailed view of the baseline noise so we can begin to 
optimize the method. 

 To rescale the plot to display an area of interest: 

1. With the chromatogram back to its original scale showing the entire run, 
choose Rescale Plot from the Display menu. 

 

2. In the Rescale Plot dialog box, make the following changes: 

a. Change End Time to .55. 

b. Change Offset to 0. 

c. Change Full Scale to 10. 

3. Click on OK to redraw the plot using the new values. 
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Your screen should look similar to the example below: 

 
 

For additional information on changing the display, see “Changing Display Options” 
in Chapter 10 of the TotalChrom User’s Guide. 

Fine Tuning Peak Detection 
Since the default peak detection settings are very sensitive, too many peaks were 
detected in our sample chromatogram due to baseline noise. 

To ensure that TotalChrom detects small peaks but does not interpret baseline noise 
as peaks, we must calculate the baseline noise and set noise and area thresholds to 
ignore it. 

 To calculate the optimal noise threshold: 

1. Choose Noise/Area Threshold from the Process menu. 

The status bar message tells you to outline the section of baseline that you 
want to use for calculating a new threshold level. 
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2. Select the entire baseline by holding down the left mouse button and 
dragging the mouse to outline the area. 

 

3. Release the mouse button to display the Noise/Area Threshold dialog box.  

 

TotalChrom has calculated the suggested optimum thresholds (these should 
be approximately 80 and 400). 

4. Click on OK to reprocess the data and redraw the plot using the suggested 
thresholds. 
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As shown in the example below, the new noise and area threshold values 
have eliminated the spurious peaks. 

 
6. Click the right mouse button to return the chromatogram to the previous 

level of expansion (full size chromatogram). 

The number of data points across a peak influences peak detection. If you have too 
many points across the peak, you can either decrease the sampling rate for future runs 
(you cannot change the sampling rate for data that is already collected) or increase the 
bunching factor to filter out unneeded data from existing files. 

The next thing we will do to optimize peak detection is to adjust 
the bunching factor. 

 To set a new bunching factor: 

1. Choose Sampling Rate/Bunching Factor from the Process menu. 

The status bar message tells you to outline the narrowest peak to use for 
calculation. 
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2. Outline the width of the first peak (do not select the tailing portion) by 
holding down the left mouse button and dragging the mouse. 

 
3. Release the mouse button to display the Sampling Rate/Bunching Factor 

dialog box. 

 
TotalChrom has calculated a recommended bunching factor of 2 in the 
example above (compared to the old bunching factor of 1 from the default 
method). 

4. With the Bunching Factor option selected, choose OK to reprocess the data 
and redraw the chromatogram using the new bunching factor. 
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The change to our chromatogram is subtle. When you optimize a method in 
your daily work, the visible changes can be significant. 

 

For more information, see “Setting Processing Parameters” in Chapter 10 of the 
TotalChrom User’s Guide. 

You have now optimized the method for peak detection and 
integration. The next step is to have TotalChrom assign names to 
some of the peaks and calculate the amount (or concentration) of 
the peaks. To do this you must create a component list. 
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Creating a Component List 
During peak detection, TotalChrom assigns a sequential number to each detected 
peak. This is referred to as the peak list. The component list, on the other hand, is a 
list you create in the method that identifies each peak as a specific component. We 
will create three components in this exercise. 

 To add single peak components: 

1. Choose Edit Components from the Calibration menu. 

 
The plot is narrowed to make room for the Edit Components dialog box: 

 
2. Click on peak 5 (retention time 2.81) to move the selection rectangle to it 

from the first peak. 

3. Select the Ref. check box to have this component act as a reference peak for 
other components. 

The reference peak is used to adjust the expected retention times during 
component identification. 

4. Select the ISTD check box to have this component act as an internal standard 
for other components. 
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The internal standard adjusts the responses for any variation in the injection 
volume. 

5. For the component name, enter Chlorotoluene. 

6. Change the entries for both Absolute Window and Relative Window to 5. 

The total search window is the sum of the absolute and relative windows, 
applied to either side of the expected retention time of the component. 

7. Select the Find Tallest Peak in Window check box. 

This will identify the tallest peak eluting within the search window as the 
designated component. 

This completes the entries for this peak. Your dialog box should look like the 
example below. 

 
8. Choose Prev to move the selection rectangle to peak 4 (the peak preceding 

peak 5). 

Note:  To save component information, you MUST choose Next, Prev, or Return. If 
you move to another peak by clicking on it instead, your entries are not saved. (This, 
however, is a way to discard entries that you do not want to save.) 
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Your screen should now look like the example below, with the component 
name below peak 5, and with peak 4 selected but not yet defined. 

 

9. For the component name for peak 4, enter 1,2-Dichloroethene. 

10. From both the Reference and ISTD drop-down lists, select Chlorotoluene. 

11. Change the Absolute Window entry to 5 (leave Relative Window set to 3). 

12. Select the Find Tallest Peak in Window check box. 

Your dialog box should look like the following example: 

 
13. Choose Prev to move the selection rectangle to 3 (the peak preceding peak 4). 
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14. For the component name for peak 3, enter Chloroform. 

15. From both the Reference and ISTD drop-down lists, select Chlorotoluene. 

16. Change the Absolute Window entry to 5 (leave Relative Window set to 3). 

17. Select the Find Tallest Peak in Window check box. 

18. Choose Return  
 
to close the dialog box. 

 
Your chromatogram is now labeled with the three components you just 
created. 

 

For additional information, see “Working with Components” in Chapter 10 
of the TotalChrom User’s Guide. 

 

We have finished building the short component list that we need 
for the tutorial. The next step is to switch to the Method Editor 
and set the calibration parameters for each component. 
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Using the Method Editor 
In this part of the tutorial you will: 

 Set calibration parameters 

 Perform a manual calibration 

You use the Method Editor to develop a complete method. It includes the parameters 
that are not available through the Graphic Method Editor or when you develop a 
quick method. 

Setting Calibration Parameters 
Calibration parameters identify and calibrate the components being analyzed by the 
method. These parameters include component names, expected retention times, and 
calibration data (the responses produced by different component amounts). 

You entered the names and expected retention times when you created the component 
list in the previous section of the tutorial. In this part of the tutorial, we will set the 
remaining calibration parameters in the Method Editor by adding calibration levels 
for each component. 

 To develop calibration parameters in a method: 

1. Choose Method from the Other menu to switch to the Method Editor and 
display the summary information for each section of the method. 
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2. Choose Edit Component from the Components menu to open the 
Components window. 

 
This window is a secondary level of the Method Editor. 

 
The names of the components that we want to identify in the analysis are on 
the left side of the window. Information for the selected component is on the 
right side. We will edit this existing information to add a calibration level for 
each component.  
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3. Highlight Chloroform, then click on the Calibration tab to open the 
calibration information dialog box for that component. 

 

Note:  The entries below are TotalChrom’s initial defaults. The default values may be 
different on your system. 

4. Select the Use Curve as the Calibration Type option. 

This creates a calibration curve based on the data collected from standard 
samples. 

5. Select Area as the Response option. 

This tells TotalChrom to calibrate and quantitate using peak area. 

6. Select Point to Point as the Curve Fit Type. 

This averages all replicate amount and response data at each calibration level 
to derive a point. Each pair of points will be connected by a straight-line 
segment to form a calibration curve. 

7. For both Scaling and Weighting, select None. 

8. Under Origin Treatment, select (check) the Include check box. 

This will add point (0,0) to the calibration (zero amount to zero response). 
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The next part of the procedure describes how to add a new 
calibration level in the area at the bottom of the dialog box. 

 
9. Click in the Level text box and enter Level 1 for the level name. 

It is recommended to enter an alphanumeric level name in this box. 

10. Click in the Amount text box and enter 30. 

The area value will be calculated and filled in when we run a calibration 
standard. 

11. If there are default entries displayed on your list (anything other than the 
Level 1 that you just entered), select each entry and press the Delete key to 
delete it. This is the procedure for deleting a calibration level. 

Once you click in the Level 2 box, your screen should look like the 
following example. 

 
12. Choose Next to display the calibration information for 1,2-Dichloroethene. 
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13. Make the same entries for 1,2-Dichloroethene that you made for Chloroform: 

Calibration Type = Use Curve 
Response = Area 
Curve Fit Type = Point to Point 
Scaling/Weighting = None 
Origin = Include 
Calibration level = Level 1 
Calibration amount = 30 
Delete the default calibration level entries, if any 

14. Choose Next to display the calibration information for Chlorotoluene. 

15. Make the same entries for Chlorotoluene as you made for the previous 
components, except that the calibration amount is 20 instead of 30: 

Calibration Type = Use Curve 
Response = Area 
Curve Fit Type = Point to Point 
Scaling/Weighting = None 
Origin = Include 
Calibration level = Level 1 
Calibration amount = 20 
Delete the default calibration level entries, if any 

16. Choose Apply, then OK to return to the Method Summary window. 

Now that we have finished adding a calibration level for each 
component, we have everything we need to perform a manual 
calibration. 

Performing a Manual Calibration 
When you manually calibrate a method, you are creating a calibration replicate. A 
replicate is an analysis of a calibration standard for a particular calibration level. 
Since it is a unique analysis, you can use replicates to average calibrations. 

When you perform a manual calibration, you build a list of result files and the 
calibration levels that you want to calibrate, and indicate the type of calibration that 
you want to perform. 
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 To perform a manual calibration: 

1. Choose Calibrate from the Components menu to open the Manual 
Calibration dialog box. 

 
2. Browse to the Examples directory, by clicking on the yellow folder icon to 

the right of the Selected Files box, and select the result file Halo003.rst from 
the File-Select dialog box. 

 
Then click Open. This will be the file that we define as a calibration standard. 



Tutorial Part 2 

 65 

3. Select Level 1, from the drop-down menu, in the Calibration Parameters - 
Level box. 

This is the calibration level of the standard file. 

4. Select Replace as the Type. 

If our method had been calibrated, this would replace the existing calibration 
replicates with the new replicates. 

5. Choose Add to add the calibration entry to the Filename/Level/Cal Type list 
on the bottom of the dialog box. 

If you had more levels to calibrate at this time, you would select the next 
file, level, and type combination and add it to the list. 

6. Select the “Identify peaks before calibrating” check box so that the peaks in 
the result file will be identified before calibration. 

Your screen should look like the example below. 

 
7. Choose OK to perform the calibration using the information in the 

Filename/Level/Cal Type list and return to the Method Summary window. 
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8. To view the updated calibration, return to the Calibration tab by selecting Edit 
Component from the Components menu, then click on the Calibration tab. 

 
Notice that the area has been calculated and is displayed at the bottom right 
of the window. 

9. Choose OK to return to the Method Summary window. 

10. To view the calibration curve, you can Choose Component List from the 
Window menu to switch from the Method Summary screen. 
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You can also switch between Method Summary and Component List by 
minimizing and maximizing the windows in the Method Editor, by clicking 
on the appropriate icons in the upper right corner of the window. 

11. To return to the Method Summary window, choose Window and select 
Method Summary. 

 
For additional information about calibration parameters, see Chapter 8 in 
the TotalChrom User’s Guide. 

Although there are many ways that you can further customize a 
method, this completes what we will do in the tutorial. Our next 
step is to save what we have done. 
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Saving a Method 
 To save this as a new method: 

1. Choose Save As from the File menu. 

2. When the Description dialog box opens, enter any information that you want 
to store with the method file. Do not select Audit trail. 

3. Choose OK. 

3. Name the method by typing practice as the File name. 

 
This saves the method as (C:\penexe\…\practice.mth). 

5. Choose Save to save the method. 

You have finished optimizing this method and have saved it for 
future use. 

The next step is to create a format for the report that will be 
printed after an analysis that uses this method. 
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Building a Report Format 
After TotalChrom analyzes a raw data file, it uses a report format file when it prints 
the results of the analysis. This file controls which parameters are included in the 
printed report and defines how the information appears on the page. 

To help you become familiar with this function, we will use the Report Format 
Editor to: 

 Title the report 

 Add, replace, and delete report columns 

 Save the report for future use 

 Creating a new report format: 

1. With the Method Editor window still displayed, choose Report Format 
Editor from the Other menu. 

Since there is no report format with this name, TotalChrom uses the name of 
the method that you have open with default values to set up a new report 
format. 

 
The first thing we will do is change the title of the report. 

2. Select Title from the User Notes menu. 

3. In the Title dialog box, change the default title to TUTORIAL REPORT. 

4. Click on OK to redisplay the report with the new title. 
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You can display most of the edit dialogs by clicking directly on the desired 
area of change (for example, click on TUTORIAL REPORT to display the 
Title dialog box). 

Next we’ll add a column to the report. 

5. To see a list of all the options for column headings, choose Report to display 
the menu. 

6. Select Component Name from the Report menu. 

 
7. In the Component Name dialog box, change the column number  

from 9 (the next available column on the default report) to 3. 

8. Choose Insert/Add. 

A column for Component Name is inserted before the Area column. The font 
becomes smaller so that the report fits on the screen, and a compressed font 
would be used when this report is printed. 

 

Now we will change a column heading by replacing it with a 
different selection. 
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9. Select Adjusted Amount from the Report menu. 

 
10. In the Adjusted Amount dialog box, change the column number from 10 to 7. 

11. Choose Replace. 

Adjusted Amount is added to the report as column 7, in place of Normalized 
Area. 

 
 

The last change we will make before saving the file is to delete a 
column from the report. 

 

12. Select Delete Column from the Edit menu. 

13. In the Delete Column dialog box, enter 9 for the column to be deleted 
(Area/Height). 

14. Choose OK. 
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Notice that with fewer column headings the font returns to its original size. 

 
15. Choose Save from the File menu. 

16. Choose Exit from the File menu to return to the method summary. 

Do not close the Method Editor window. 

For additional information about report formats, see Chapter 9 in the TotalChrom 
User’s Guide. 

Now that we have optimized and saved the practice method, we 
will build a sequence that specifies this optimized method file. 

Building a Sequence 
Sequences are used to control acquisition and analysis of chromatographic data 
produced by a series of injections. 

For the purpose of this tutorial, we will build a sequence that we will use to reprocess 
stored data. To do this, we will use the sequence template and the sequence spreadsheet. 

Note:  In most cases, an .idx file would be used for reprocessing data. We will discuss 
.idx files, and their use, at the end of this section. 

Using the Sequence Template 
The sequence template simplifies the process of creating a sequence by letting you 
define its essential structure in one dialog box. 

 To build a sequence using a template: 

1. With the Method Editor window still displayed, choose Sequence Editor 
from the Other menu. 
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When the Sequence Editor window opens, the sequence spreadsheet may 
also be displayed. We will come back to it later. 

2. In the Sequence Editor window, choose New from the File menu. 

This opens the Global Parameters dialog box: 

 
3. In the Build Parameters tab, select your instrument name from the 

Instrument pull down menu. 

4. Select “From template” as the Build option. 

5. Click on the Configuration tab. 

 
6. Select “Single” for Injection Type option. 

7. Select “One per row” for Methods option. 
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8. Select “Same name” for Raw data and Result files option. 

9. Choose OK to open the Sequence Template dialog box. 

 
This dialog box is where you enter all the information that you need to create 
a basic sequence. 

10. In the “Study” text box, type the name TUTORIAL to identify the analysis 
being performed. 

11. In the “Method” text box, browse to the examples directory, by clicking on 
the yellow folder icon to the right of the method box, and select 
C:\penexe\…\practice.mth. 

We want to use our newly optimized method to reprocess existing raw data files. 

12. Change the “Base file name” to HALO for Channel A. 

Note: HALO is the name of a group of raw files that are supplied with TotalChrom as 
examples. We cannot use the raw file that you acquired in Part 1 of the tutorial since 
every user has a different one. 

This will be the base name of the raw and result files that will be listed in the 
sequence spreadsheet. 

13. In the Calibration box, deselect “Include calibration standards” by clicking 
on the check box. 

We already calibrated the method manually in the Method Editor. 
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14. In the Samples box, enter 3 for the “Number of samples” to be analyzed in 
the sequence. 

15. In the Samples box, enter 1 in the “# Injections per sample.” 

16. Choose OK to close the Sequence Template dialog box. 

When you complete the sequence template, TotalChrom builds the sequence. You 
can then view and edit the sequence data in spreadsheet form. 

Using the Sequence Spreadsheet 
The parameters in a sequence can be displayed in spreadsheet form in the Sequence 
Information window. Using the spreadsheet is the easiest way to edit an existing 
sequence. 

 
Your sequence spreadsheet should have 3 rows, the number of samples you specified 
in the template. Each row contains information about the sample and the values that 
will be used when the raw data is reprocessed. To see the following columns and 
information you will have to scroll the sequence spreadsheet window to the right: 

 The Method column shows the name of the method file. 

 The Report column is the name of the report format file that will be used to 
generate the report. 

 The Data column identifies which files will be reprocessed. 

 When you build a sequence to acquire a series of injections, this entry will 
be the base file name of the raw files that are created. 

 The parameters that you did not change contain either the default value or no 
value. 

Note: The columns that are displayed may vary depending on which options were 
selected in the Global Parameters, Configuration tab or user defined “hidden” 
columns. 
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The Edit menu is the same menu we saw when we developed the vial list in the Part 1 
of the tutorial. It offers several choices for manipulating rows in the spreadsheet. 

We will use the Change menu to change the paths for the data files so TotalChrom 
will know to look for them in the Examples directory rather than the Tutorial 
directory. 

 To edit a sequence using the spreadsheet: 

1. Choose Path from the Change menu to open the Change Path dialog box. 

 
2. Enter  3  for the Ending Row. 

3. Enter an asterisk  *  in the “Path to change” text box. 

4. In the “New path” text box, browse to the Examples directory by clicking on 
the yellow file folder to the right of the text box. 
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5. Under “Change path for”, select Data. 

 
6. Choose OK. 

You will notice that the full path is now displayed in the Data column and 
that it now points to the Examples directory. 

 

 To change the printer information in the sequence. 

1. Scroll the spreadsheet window horizontally until the printer and plotter 
columns are visible. They are at the far right of the spreadsheet. 

2. Select the cell for row 1 of that column by clicking inside it. 
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The Default printer is your default Windows printer as shown below. 

 
3. Click on the Printer pull down menu and select the entry that represents the 

printer you want to use. 

4. Do the same for the Plotter column. 

5. Choose Fill Down from the Change menu to copy the entry from row 1 to 
every cell in the column.  

Right clicking on the cell and selecting Fill Down can also accomplish this. 

 
 To save this sequence as a new sequence: 

1. Choose Save As from the File menu. 

2. When the Description dialog box opens, enter any information that you want 
to store with the sequence file. Do not select Audit trail. 
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3. Choose OK. 

4. In the Save As dialog box, name the sequence practice. 

This saves the sequence as    C:\penexe\….\practice.seq. 

 
5. Choose Save to close the dialog box and save the new sequence file. 

For more information on sequences, see Chapter 11 in the TotalChrom User’s Guide. 

Now we are ready to use this sequence with the Batch Reprocessing 
function. 
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Batch Reprocessing a Sequence File 
Once you have acquired data and stored it in a raw data file, you can process that data 
repeatedly. The Batch Reprocessing function enables you to reprocess a large number 
of files in succession. 

One of the purposes of reprocessing data is to re-analyze the raw data files listed in a 
sequence. For our last exercise, we will use the sequence file we just created to 
reprocess data files with our optimized method. 

 To reprocess files in a sequence: 

1. Select Batch from the Actions menu. 

Because we selected the Batch Reprocessing function when we had a 
sequence open, that sequence is supplied as the default. 

 
2. Choose your “Actual data path” by clicking on the yellow folder and 

browsing to the Examples directory. 

The Data Path is the directory where your Raw and Result files are stored. If 
you used the full path for your data files in the sequence spreadsheet, which 
we did in the previous exercise, you can leave this field blank. 
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3. Click OK. 

4. Choose PEAK DETECTION as the “Start analysis” and REPLOT 
GENERATION as the “End analysis.” 

5. Choose Local (if you have Client/Server) or Interactive (if you have 
Workstation) for the “Batch execution.” 

6. Select “Overwrite existing result files.” 

7. Choose OK to accept the rest of the default settings. 
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The Batch Reprocessing window opens, listing the raw files that are 
scheduled for reprocessing. They are the three files from our sequence. 

 
8. Choose Start from the Reprocess menu to begin reprocessing the data. You  

can also start the Batch process by clicking on the green arrow on the toolbar. 

The entries on the list are deleted as they are processed. The report and replot 
for each file will be printed once data analysis is complete. 

9. To close the Batch Reprocessing window and return to the Navigator, choose 
Exit from the File menu. 

For more information on batch reprocessing, see Chapter 15 of the TotalChrom 
User’s Guide. 

Viewing Results using Reprocess Results 
Once Reprocessing is complete, you can view the results using Reprocess Results. 

 To view the result files in Reprocess Results: 

1. Click on the Results button from Reprocess buttons on the Navigator. 
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2. Select the Halo003.rst file from the Examples directory. 

 
3. Click Open. 

 
You will notice that the Halo003.rst file now has the method parameters 
applied to it that you specified in the practice.mth that you created in the 
Graphic Method Editor. 

4. By either using Print Preview, or looking at the printed report, you will 
notice that the processing method that was used for this data file is the 
practice.mth method that you created. 
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Your printed report should resemble the above report. 
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Review and Approve Data 
This environment will consist of three main windows: one containing a list of sample 
information (the “file list”), another containing a chromatogram plot, or plots, (the 
“plot window”) of the currently selected sample, or samples, from the file list, and the 
third containing a report displaying results from those samples (the “report window”). 
These separate windows will be implemented as docking windows, so that the user 
may adjust the layout and relative sizes of the windows to his or her liking. This 
layout will be saved as part of the environment preferences (in an INI file located in 
the individual user’s subdirectory under the penexe.  

 

The display of any window may be toggled on or off using menu commands or 
toolbar buttons.  Each window may also be closed using the ‘close’ button on the 
docked window itself. Each window may be toggled between normal size and 
maximized in the usual way for docking windows (i.e. the arrow button incorporated 
in the frame). 

The docking scheme will be implemented such that the open docked windows 
completely fill the parent window. While it will be possible to undock a window there 
is little point in doing so. Docking will be used here to allow a flexible layout with 
easy relative sizing of windows, rather than any other purpose. 

When a single file is selected in the file list, the plot window displays the 
chromatogram from that file and the report window displays results from that run (if 
available). The chromatogram can be annotated with sample information, peak names 
and/or other peak information, baselines and labels added by the user. The result data 
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can be displayed in the form of a simple peak table and/or in a specific TotalChrom 
report format as defined by a .rpt file. 

When more than one file is selected in the file list, the plot window displays all the 
chromatograms, in either a stacked or overlay display format and the report window 
displays a table containing a summary of results from all the files. There is no 
arbitrary limit to the number of chromatograms that can be displayed – the stacked 
mode is quite valid for any number of plots. 

The following example is a scenario of how the Review and Approve process could 
be used.  This example has been developed to illustrate some key aspects of the 
Review and Approve specification; it is neither the simplest nor the most complex 
path through the application. While the scenario aims to be accurate in its depiction of 
review and approve, it does not attempt to be completely realistic in all matters. 

Set Up Conditions 
The configuration of the TotalChrom system for this example contains the following 
key items: 

Review and Approve signature levels:   
Review, Final Review, Final Approve and Hold 

Review and Approve options:    
The same user cannot sign two levels for a report = True.  You must enter a comment 
for each Hold report = True 

Job Types:    
Manager, Analyst, Technician 

Users:   
Susanna (Manager), Michael (Senior Analyst), Vicky (Analyst), and James (Lab 
Technician) 

Review and Approve permissions:     

Susanna – Final Approve, Hold 
Michael – Final Review, Hold  
Vicky – Review 
James – no permissions 

The sample data set for this example consists of three samples (CK46123, CK46124 
and CK46125) each of which has two associated reports (Actives and Impurities).  
Processing of these samples yielded three TCR files, each containing two report 
definitions.  

Vicky has reviewed the results in the Review and Approve environment and signed 
each report, such that each now has the status of Reviewed.   
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In this Example  

1. Michael logs on to TotalChrom on one of the lab computers and opens the 

Review and Approve environment by clicking the   button in the 
TotalChrom Navigator. He prefers to be away from his office phone when 
reviewing reports.  

2. He selects the three TCR files representing the CK46123, CK46124 and 
CK46125 sample reports in the File Open dialog and clicks OK.   

The Signature Status column in the file list shows Reviewed for all three TCR 
files, as Michael expects (knowing Vicky came in on Sunday to review the 
samples after James had finished the chromatographic runs).  The chromatogram 
and Actives report for the first sample are displayed in the Plot and Report 
windows.   

3. He zooms in on the chromatogram to examine the integration and baseline for 
each peak of interest in turn.   

All look satisfactory. Michael repeats this process for the two remaining TCR 
files. The chromatography and integration looks fine for all three samples.   

4. Now he wants to review the reports more closely prior to signing them so he 
chooses the All Reports command from the Sign menu. 

The Report Review window appears with the Actives report for sample CK46123 
displayed.  Michael notes that the Review, Final Review and Hold buttons are 
enabled on the Sign toolbar, while the Approve and Final Approve buttons are 
disabled.  

 

He will not use the Review button since the company SOP only requires two 
levels of review. He also hopes he won’t be using the Hold button because 
rejecting batches of product leads to a lot of paperwork and unwelcome attention 
from upper management.  Once he has applied a Final Review signature to these 
reports they will be ready for Susanna to give Final Approval.  

5. Michael clicks the Zoom In button so that the report text is at a size that is 
comfortable for him to read. He then checks the header information carefully to 
make sure the correct methods were used.  Clicking the scroll bar, he examines 
the peak table to ensure the reported amount of each active component is within 
limits and that the suitability parameters are within tolerance.  

6. When he is satisfied that all is as it should be Michael clicks the Final Review 
button.  
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The Impurities report for CK46123 is then displayed. Michael reviews the header 
information again and checks the amounts for each impurity, as well as the figure 
for total impurities. All these values are well within limits and so Michael clicks 
Final Review once again. 

7. Michael repeats his examination on the reports from CK46124. Both of these are 
also satisfactory, so he marks both using the Final Review button.  

8. The Actives report for CK46125 also appears acceptable, so he clicks Final 
Review once more.  This causes the Impurities report for CK46125 to be 
displayed. Michael notes that the individual impurities are just within limits but 
the total is too high.   

9. He double-checks the addition manually but he knows the TotalChrom custom 
expression math is flawless. “That process may be getting out of hand he thinks 
to himself, as he clicks the Hold button.  

The Reason for Hold is displayed and, following the SOP, Michael types in an 
explanation of why he is not approving the report.   

10. He clicks OK and the notes that the report name in the status bar of the Review 
Reports window is now followed by (Hold – Unsigned).  Since that was the final 
report in the set, the Close button has been replaced by Finish, indicating he has 
reviewed everything.  

11. Michael clicks the Finish button and the Sign reports dialog is displayed. This 
shows the three TotalChrom Report files he originally selected as top level nodes 
on the tree control.  Each top level node has two second–level nodes under it, 
representing the individual reports.  The Status to be Signed column shows three 
Reviewed – Final and one Hold: 

C:\data\september\09\CK46123.tcr 
C:\data\september\09\actives_r2.rpt Reviewed – Final 
C:\data\september\09\impurities_r3.rpt Reviewed – Final 

C:\data\september\09\CK46124.tcr 
C:\data\september\09\actives_r2.rpt Reviewed – Final 
C:\data\september\09\impurities_r3.rpt Reviewed – Final 

C:\data\september\09\CK46124.tcr 
C:\data\september\09\actives_r2.rpt Reviewed – Final 
C:\data\september\09\impurities_r3.rpt Hold 

12. Michael clicks on the Sign button and the Electronic Signature dialog appears.  

13. Michael enters his user name (logon ID) in the first field and his password in the 
second field.  
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14. When he clicks the OK button the display returns to the main Review and 
Approve screen. The file list still contains the three TCR files for samples 
CK46123, CK46124 and CK46125.  The Status column now displays Reviewed 
– Final for the first five reports and Hold for the final report. 

At that moment Susanna walks into the lab.  Debbie said that the analyses that 
had to be run again over the weekend. “Well, I can tell you that Debbie isn't 
going to be happy because one sample is no good. CK46125 has too high a total 
level of impurities.  We can’t let it go.”  “How about the others”, asks Susanna. 

CK46123 was well within limits and CK46124 was between the two.”  “Well I 
suppose we should be grateful that two out of three are OK.” “Do you want to 
look these over, since you are here right now?” asks Michael, offering his chair 
to Susanna. “Sure”, she replies, and sits down at the computer. 

15. Susanna chooses the All Reports command from the Sign menu and examines 
each report in turn in the Review Reports window. The first five reports are all 
marked with the Reviewed – Final status that Michael signed off. 

16. Susanna clicks the Final Approve button for each of these. After the fifth click, 
the final report is displayed and Susanna notes the Hold designation in the status 
bar.  

17. She clicks the Comment button, which is the only button in the Sign toolbar 
enabled, since the current unapproved report has a comment attached.  A dialog 
is displayed showing Michael's reason for holding the report.  

“You misspelled phenylethyllonamide, Michael”, Susanna teases. “That’s not 
like you.” 

18. Susanna closes the comment dialog and clicks the Finish button, reviews the 
names of the five reports she is signing in the Sign Reports dialog, clicks the Sign 
button and finally enters her logon name and password in the Electronic 
Signature dialog.  

When she accepts that dialog the file list in the main Review and Approve 
window is updated to show the following Signature Statuses for the three sample 
files: 

C:\data\september\09\CK46123.tcr           Reviewed – Final 

C:\data\september\09\CK46124.tcr           Reviewed – Final 

C:\data\september\09\CK46124.tcr           Hold 

At that moment James rushes into the lab. “Good Morning, James” says Michael. 
“Hi Mike, I was hoping Susanna would be with you. Debbie is waiting for you in 
your office, Susanna. She asked me to get you right away.”  “OK, I'll go and 
break the bad news to her.”  “Call on me if you need support”, Michael calls after 
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Susanna as she leaves the lab. “That's what the PerkinElmer salesperson said”, 
replies Susanna, “but that TotalChrom software is so easy to use I have never had 
to.”. 

Congratulations! 

 
You have successfully completed the TotalChrom Tutorial. 

This tutorial was designed to give new users a brief overview of how to setup and run 
a chromatograph with the TotalChrom software. There are many different features 
and options available in TotalChrom that were not discussed in this tutorial. We 
strongly recommend that all users read the TotalChrom User’s Guide carefully in 
order to fully understand this application and how it works.  

It is also advised that new users consider attending a TotalChrom training class to 
supplement this tutorial. To find out more information about a training class in your 
area, please contact 1-800-762-4000. 

The global TotalChrom Support Team is readily willing to help you with any 
questions or difficulties you might experience while using the TotalChrom software. 
To reach your TotalChrom support representatives, call 1-800-762-4000 (U.S. and 
Canada). For our international users, please contact your local PerkinElmer office. 


